Introduction

This document describes how to use the EVB-LAN9252-PICtail™ Software Development Kit as a development tool for the Microchip EVB LAN9252 EtherCAT® slave controller.

The following abbreviations are used in this Document:

- IDE - Integrated Development Environment
- ESC - EtherCAT Slave Controller
- EVB - Engineering Validation Board
- HAL - Hardware Abstraction Layer
- SPI - Serial Protocol Interface
- SSC - Slave Stack Code
## Table of Contents

Introduction......................................................................................................................1

1. EtherCAT Pin Connection Guide Details................................................................. 3
   1.1. EtherCAT on SAME54............................................................................................3
   1.2. Hardware Setup......................................................................................................3
   1.3. SAME54 Xplained Pro Overview..........................................................................5
   1.4. EVB-LAN9252-PICtail Add-On Board.................................................................5
   1.5. Starter Kit I/O Expansion Board...........................................................................7
   1.6. LAN9252 PICTAIL PLUS and I/O expansion INTERFACE.................................9

2. EVB LAN9252-PICtail Add On Board (SPI Mode)..................................................11
   2.1. EtherCAT Master and Slave Configuration.........................................................11
   2.2. Demonstration......................................................................................................12

3. Appendix A.............................................................................................................. 15

4. Appendix B.............................................................................................................. 20

5. Appendix C.............................................................................................................. 22

6. Appendix D.............................................................................................................. 26

7. Appendix E.............................................................................................................. 34

8. Appendix F.............................................................................................................. 38

9. Appendix: Revision History......................................................................................40

The Microchip Web Site................................................................................................. 41

Customer Change Notification Service..........................................................................41

Customer Support..........................................................................................................41

Microchip Devices Code Protection Feature............................................................... 41

Legal Notice...................................................................................................................42

Trademarks.....................................................................................................................42

Quality Management System Certified by DNV............................................................ 43

Worldwide Sales and Service.........................................................................................44
1. **EtherCAT Pin Connection Guide Details**

1.1 **EtherCAT on SAME54**

This document describes the hardware setup and I/O pin connections between the SAME54 Xplained Pro evaluation kit (*Part Number: ATSAME54-XPRO*) and the EVB-LAN9252-PICTail add-on board (*Part Number: EVB-LAN9252-PICTAIL*) through the Starter Kit I/O expansion board (*Part Number: DM320002*) required to run the EtherCAT solution on the SAME54 device.

This document provides a brief information about the development board, PICtail board, evaluation kits, respective I/O pins, and connectors required for this evaluation setup.

For detailed information and schematics for each of the boards described above, refer to the respective user guide’s and Information sheets which are available for download from the following location:


1.2 **Hardware Setup**

Soldering the required pins using smaller strands of wire is recommended, as shown in the following figure. The use of fly wires will cause SPI high frequency signal integrity issues.
Figure 1-1. SPI and Interrupt Pin HW Setup

SAME54 Xplained Ultra Board

EtherCAT HOST

SYS CLK : 120MHz
SPI : 20MHz

EXT-1 Connector

SCK - PIN18
MOSI-PIN16
SS-PIN15
MISO – PIN17

EXT-2 Connector

SYNC1-PIN14
SYNC0-PIN08
ESCIIRQ-PIN06
GND-PIN19

J10 Connector

PIN 41
PIN43
PIN46
PIN 44

SPI Lines

Join Common Ground

Table 1-1. SPI and Interrupt Board-to-Board Fly Wire Pin Connection

<table>
<thead>
<tr>
<th>Functions</th>
<th>SAME54 Port Pins (Header-Pin)</th>
<th>Starter Kit I/O Expansion Board Pin Connections</th>
<th>LAN9252 EVB Pic-Tail Pin Connections</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>J10 Test Point Headers</td>
<td>J4 Edge Connector</td>
</tr>
<tr>
<td>SPI SCK</td>
<td>PB26 (EXT1-18)</td>
<td>41</td>
<td>3</td>
</tr>
<tr>
<td>SPI MOSI</td>
<td>PB27 (EXT1-16)</td>
<td>43</td>
<td>7</td>
</tr>
<tr>
<td>SPI SS</td>
<td>PB28 (EXT1-15)</td>
<td>46</td>
<td>1</td>
</tr>
<tr>
<td>SPI MISO</td>
<td>PB29 (EXT1-17)</td>
<td>44</td>
<td>5</td>
</tr>
<tr>
<td>SYNC1</td>
<td>PB16 (EXT2-14)</td>
<td>38</td>
<td>17</td>
</tr>
<tr>
<td>SYNC 0</td>
<td>PB15 (EXT2-8)</td>
<td>37</td>
<td>18</td>
</tr>
<tr>
<td>ESC IRQ</td>
<td>PB06 (EXT2-6)</td>
<td>36</td>
<td>49</td>
</tr>
</tbody>
</table>

Users need to ensure that both the boards are on common GND.
1.3 SAME54 Xplained Pro Overview

The SAM E54 Xplained Pro evaluation kit is a hardware platform to evaluate the ATSAME54P20A. The evaluation kit offers a set of features that enables the ATSAME54P20A users to get started with the SAM E54 peripherals and to have an understanding of how to integrate the device in their design.

Figure 1-2. SAM E54 Xplained Pro Evaluation Kit

1.4 EVB-LAN9252-PICtail Add-On Board

The EVB-LAN9252-PICtail add-on board is used for evaluating Microchip's LAN9252, a 2/3-port EtherCAT slave controller with dual integrated Ethernet PHYs.

Features
  • The EVB-LAN9252-PICtail add-on board supports the option to select HBI PDI and SPI/SQI configurations
- An onboard EEPROM to configure the EtherCAT slave configuration
- The EVB-LAN9252-PICTail add-on board supports two Integrated PHY’s through on board RJ45 Connectors

Figure 1-3. EVB-LAN9252-PICTAIL ADD-ON BOARD
1.5 Starter Kit I/O Expansion Board

The Starter Kit I/O expansion board provides the starter kit and starter board users with full access to MCU signals, additional debug headers, and connection of PICtail Plus daughter cards. The MCU signals are available for attaching prototype circuits, or monitoring signals with logic probes.
Figure 1-5. Starter Kit I/O Expansion Board

Figure 1-6. Starter Kit I/O Expansion Board J4 Connector
1.6 **LAN9252 PICTAIL PLUS and I/O expansion INTERFACE**

Plug in the EVB-LAN9252-PICtail add-on board J1 edge connector to the topmost position of the J4 slot on the Starter Kit I/O expansion board, as shown in the following figure.
Figure 1-8. LAN9252 PICTAIL-I/O Expansion Interface
2. EVB LAN9252-PICtail Add On Board (SPI Mode)

2.1 EtherCAT Master and Slave Configuration
The following steps describe how to configure the EtherCAT master and slave.

1. Configure the master with the TwinCAT driver.
   Note: Refer to Appendix A for information on Windows® configuration.

2. Unzip and extract the LAN9252-SAME54-SDK-Vx.x.zip file.
   Note: Vx.x denotes the version number of the SDK.

3. In SDK, \ESI Files directory contains the ESI file, which can be loaded to the EVB LAN9252-PICtail EEPROM using the TwinCAT utility, SAME54 EtherCAT slave.xml.
   Note: Refer to Appendix D to change the vendor ID and the slave information in the ESI files.

4. Copy the Microchip_LAN9252_SSC_Config.xml file to the directory path: C:\TwinCAT\3.1\Config\Io\EtherCAT for TwinCAT 3.1.


6. To program the default ESI file of the SAME54 firmware for the SAME54 controller, refer to Appendix D and Appendix E.
   Note: The pre-built binaries are available in the Binaries directory.

7. Launch TwinCAT and then scan the EtherCAT slaves from TwinCAT. Refer to Appendix C for information on how to scan the slaves.

8. Program the EEPROM using the SAME54 EtherCAT Slave.xml file. Refer to Appendix B before programming the EEPROM. If the EEPROM is programmed successfully, the device state will enter into OP mode as shown below.

   Figure 2-1. Device OP Mode

9. Once the EEPROM is programmed successfully, the state of the device will change to OP mode.
   Note: If the device changes to OP mode, then the device is in an operational state. If the device is not in OP mode, then there is an issue with the setup.
2.2 Demonstration

This section describes the demonstration of the EVB-LAN9252-PICtail in SPI mode.

1. Follow the steps as provided in EtherCat Master and Slave Configuration. There is one input and one output. The object variable can be seen in the solution explorer of the TwinCAT tool as shown in the following figure.

   Figure 2-2. EtherCAT Slave Variable Addition

   ![EtherCAT Slave Variable Addition](image)

As part of this demonstration, two object variables are available and are described in the following table.

<table>
<thead>
<tr>
<th>Table 2-1. Output Process Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counter</td>
</tr>
<tr>
<td>Trigger</td>
</tr>
</tbody>
</table>

2. To change the Trigger value, click on the Trigger which is available under ‘Output process data mapping’ in the Search Solution Explorer window as shown below. The TwinCAT project window will be displayed.
3. Change the Trigger value to a five or zero as shown in the following figure (The Trigger value can be anything. The Trigger value used here is only an example).

**Figure 2-4. Initial Trigger Variable**
4. The Counter value will be incremented based on the Trigger value as shown in the following figure. (The Counter value will not be a stable value, and will keep the increment based on the Trigger value. The following figure is shown as an example).
3. **Appendix A**

**Setting up Master in Windows**
To setup master in Windows, follow these steps:

1. Download and install TwinCAT 3.1 on Windows from the following location: [http://beckhoff.com/](http://beckhoff.com/).
2. TwinCAT Ethernet driver installation:
   - If the TwinCAT tool is installed successfully, a TwinCAT icon will be shown in bottom-right corner of the desktop. After clicking the icon, a pop-up window will be displayed. Select `TwinCAT XAE (VS XXXX)` as shown in the following figure.

   **Note:** VS XXXX refers to version of the Visual Studio installed on the computer.

   ![TwinCAT Manager](image1)

3. On the TwinCAT Project1 window, from TWINCAT > Show RealTime Ethernet Compatible Devices.

   **Figure 3-2. Show Real Time Ethernet Compatible Devices**

4. Select the Network adapter, and then install the TwinCAT driver.
5. Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master. Now the network adapter is moved under *Installed and ready to use devices* as shown in the following figure.
6. Go to the corresponding network adapter properties by clicking *View network status and tasks* and *Change adapter settings* in the Control Panel.

*Figure 3-5. Configure Network Adapter Properties*
7. Select the TwinCAT drivers as shown in the following figures. Right-click on Local Area Connection and then select Properties from the short-cut menu. The Local Area Connection properties window will be displayed, see below image.

**Figure 3-7. Network Adapter Properties Menu**
8. Select TwinCAT Ethernet Protocol, and then click **OK**.
Appendix B

EEPROM Programming
To program the EEPROM, follow these steps:

1. After a successful scan, click on Device 2 (EtherCAT) in the solution explorer window of the TwinCAT tool as shown in the following figure.

   Figure 4-1. TwinCAT Scans EtherCAT Device2

2. Click Online in the TwinCAT project window.

3. Right-click on the LAN9252 listings, and then select EEPROM Update from the contextual menu.

   Figure 4-2. Select LAN9252 Setting for EEPROM Update

4. Upon selecting EEPROM Update, the Write EEPROM window will be displayed. Choose the corresponding EEPROM configuration, and then Click OK to initiate the EEPROM programming.
5. The above figure shows an example of the LAN9252 SPI configuration selected for EEPROM programming in the TwinCAT.
Appendix C

Scanning EtherCAT Slaves
To scan EtherCAT Slaves, perform these actions:

1. Connect Port zero of the device to the master using a RJ45 Ethernet cable, and then power up the board. The Link/Act LED should be ON at Port zero when the cable is present. If the Link/Act LED is not ON, it indicates there is an issue with the connection or cable.

2. If any devices are present, delete them by right-clicking the device and select Remove as shown in the following figure. If there are no devices in the solution explorer, then skip this step.

   **Figure 5-1. Remove Previous Scanned EtherCAT Slave Devices**

3. If master is in RUN mode, then it will not detect the slave as described in the steps five and six. Ensure that the master is in Config mode, by clicking Restart TwinCAT.
4. Scan for EtherCAT slave devices by right clicking Devices and then select **Scan** as shown in the following figure.

**Figure 5-3. Scan EtherCAT Slaves**

5. Click **OK** to continue scanning as shown in the below image.
6. If the check box is not selected as shown in the following figure then either the device is not functional, or the driver is not installed properly.

   Figure 5-5. Device Dialog, Unchecked

7. Click Yes to choose to scan for boxes.
8. After a successful scan, there will be activity on Link/Act LED at Port zero.
Appendix D

Generating EtherCAT Slave Stack Code (SSC) files

To generate the SSC files, follow these steps:

1. Select the SSC tool (Version 5.11) from the Start menu, as shown in the following figure.
   
   Figure 6-1. SSC Tool Installation Steps

2. From the File menu select New to continue.
   
   Figure 6-2. New EtherCAT Slave

3. Click Import to import the SSC Tool configuration file, Microchip-SAME54-EtherCAT-Slave_SSC_Config.xml, from the directory {SDK_INSTALL_PATH}/LAN9252-SAME54-SDK-Vx.x/.

© 2018 Microchip Technology Inc.
4. After selecting the file, click **Open** to import the SSC Tool configuration file.

5. Once imported, from the Custom drop-down menu, select the **Microchip_LAN9252_SSC_Config**, and then click **OK**.

**Figure 6-4. Custom SSC File Selected**

6. After selecting the configuration, the SSC will prompt for the **9252_HW.c** file. Click **OK** and choose the **9252_HW.c** file from this path: `{SDK_INSTALL_PATH}/LAN9252-SAME54-SDK-Vx.x/SSC/Common`. 
7. All listed parameters under **Slave Information** can be changed as shown in the following figure.  
**Note:** By default, SDK ESI files have an object configuration with a Microchip vendor ID.
8. Tool > Application > Import.

9. Select the sample_app.xlsx file, which is available in the directory `{SDK_INSTALL_PATH}/LAN9252-SAME54-SDK-Vx.x / Sample application`. The sample_app.xlsx object file contains the information about application objects.
10. Once the file is selected, status message will be displayed as shown in the following figure. Click **OK** to continue.

**Figure 6-9. Status Message**

11. Click the **Project** drop-down menu in the tool bar, and then select **Create New Slave Files**. The following figure shows the pop up window.
Figure 6-10. Create New Slave Files

Note:

$PROJECT_FILE_PATH – The location where the SSC project file is saved.

$SRC_FILE_PATH – Default path is $PROJECT_FILE_PATH. It can be changed by clicking the Change button in the pop up.

$ESI_FILE_PATH – Default path is $PROJECT_FILE_PATH. It can be changed by clicking the Change button in the pop up.

12. Click Start to create a new project file, the SRC folder, and the ESI file (Slave Information file) in the desired directory path.

13. A pop-up window indicates that the files are successfully created. Click OK to continue.

14. Along with generated new slave files, the ESI file (.xml file) also will be generated. This ESI file will have information about the new vendor ID and object configuration. Program this ESI file into the EEPROM as mentioned in Appendix B.

15. Replace the generated application files in the SRC folder with the SDK application files as shown in the following figure.
   – The SDK Application files can be found in Sample application.
16. Application files are named as `sample_app`. In this demonstration, the input object file is named as `sample_app.xlsx`.

17. Browse to the directory where new files are created:
   - SRC (Folder): Contains the Beckhoff Slave Stack code.
   - SAME54 EtherCAT Slave (ESP): The SSC Tool project file.
   - SAME54 EtherCAT Slave (XML): The EtherCAT slave information file, must be used as an input to the EtherCAT master tool to configure the EtherCAT slave controllers.
18. Copy above mentioned files into the **SRC** folder under the directory: `{SDK_INSTALL_PATH}/LAN9252-SAME54-SDK-VX.X /SSC/Common`.

**Note:** The file replacement is required for these reasons:

- The default `sample_app.c` file does not have the counter and trigger configuration details, hence the user can add the modifying code for the counter and trigger.
- The generated application files will not have the code for modifying the Output Counter. Modifying the Output Counter based on the Input trigger value in the sample application provided, is delivered in the SDK application files. It is required to run the demonstration application.
7. Appendix E

Compiling and Programming SOC Firmware
To compile and program the SOC firmware, follow these steps:

1. Open Atmel Studio 7. From File > Open > Project/Solution and then import the SSC project into the IDE. The Atmel Studio Project file is located under {SDK_INSTALL_PATH}/LAN9252-SAME54-SDK-VX.X/SSC/SAM.

   Figure 7-1. Open Project in Atmel Studio

2. Browse to the project location and then open the Atmel Studio solution file etherCATSamE54.cproj.

   Figure 7-2. EtherCAT Project Path

3. Project will be loaded as shown in the following figure.
4. The SSC generated files are not added into the SDK distribution. Therefore, as the project is loaded into the IDE, the following files are not located by the IDE.
Figure 7-4. EtherCAT Library SSC Generated Files

Ensure that required files are generated and added to the appropriate location
\{SDK_INSTALL_PATH\}/LAN9252-SPISAME54_SDK_V1.0_alpha/etherCATSamE54/SSC/Common.

Refer to Appendix D on how to generate the EtherCAT Slave Stack files using the SSC tool.

The application files are required to be generated and added to the appropriate location. Refer to Appendix D.

5. Compile the source code as shown in the following figure.

Figure 7-5. Compile the EtherCAT Project

6. Once the source code is compiled successfully, the output window will display a build successful message as shown in the following figure.
7. Before initiating the firmware download, ensure that the debugger, programmer, and Xplained Pro board are connected to the device which is running Atmel Studio.

8. To debug the SAME54 host, click **Debug Main Project**.

**Figure 7-7. Debug Main Project**
8. Appendix F

Programming the SAME54 Firmware Using Pre-Built Binaries

1. Download and install Atmel Studio v7.0 from the following location: https://www.microchip.com/avr-support/atmel-studio-7.

2. Before initiating the firmware download, ensure that the debugger, programmer, and Xplained Pro board is connected to the device running Atmel Studio 7.

3. Open Atmel Studio and from Tools > Device Programming.

   Figure 8-1. Select Device Program Option

4. In the Device Programming window, under Tools, select the options as shown in the following figure.

   Figure 8-2. Select Device to Program

5. Select the options under Device as shown in the following figure.

   Figure 8-3. Select Atmel Device

6. Click Apply.

   Figure 8-4. Apply Programming

7. Click Memories and then browse to the .hex file location.
Figure 8-5. Erase Flash Memory

8. Once the .hex files are loaded, click Program to program the SAME54 firmware.

Figure 8-6. Select EtherCAT Binary File
9. **Appendix: Revision History**
   November 2018
   This is the initial released version of this document.
The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQ), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.


Customer Support

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

**Legal Notice**

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

**Trademarks**

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBloxx, KeeLoq, Kleer, LANCheck, LINK MD, maXSylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTorch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntellIMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTIP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KEELIQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
**Worldwide Sales and Service**

<table>
<thead>
<tr>
<th>AMERICAS</th>
<th>ASIA/PACIFIC</th>
<th>ASIA/PACIFIC</th>
<th>EUROPE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Corporate Office</strong></td>
<td><strong>Australia - Sydney</strong> Tel: 61-2-9868-6733</td>
<td><strong>India - Bangalore</strong> Tel: 91-80-3090-4444</td>
<td><strong>Austria - Wels</strong> Tel: 43-7242-2244-39</td>
</tr>
<tr>
<td>Chandler, AZ 85224-6199 Tel: 480-792-7200 Fax: 480-792-7277 Technical Support: <a href="http://www.microchip.com/support">http://www.microchip.com/support</a> Web Address: <a href="http://www.microchip.com">www.microchip.com</a></td>
<td><strong>China - Beijing</strong> Tel: 86-10-8569-7000</td>
<td><strong>India - New Delhi</strong> Tel: 91-11-4160-8631</td>
<td><strong>Denmark - Copenhagen</strong> Tel: 45-4450-2828</td>
</tr>
<tr>
<td><strong>Atlanta</strong> Duluth, GA Tel: 678-957-9614 Fax: 678-957-1455</td>
<td><strong>China - Chengdu</strong> Tel: 86-28-8865-5511</td>
<td><strong>India - Pune</strong> Tel: 91-20-4121-0141</td>
<td><strong>Finland - Espoo</strong> Tel: 358-9-4520-820</td>
</tr>
<tr>
<td><strong>Austin, TX</strong> Tel: 512-257-3370</td>
<td><strong>China - Chongqing</strong> Tel: 86-23-8980-9588</td>
<td><strong>Japan - Osaka</strong> Tel: 81-6-6152-7160</td>
<td><strong>France - Paris</strong> Tel: 33-1-69-53-63-20</td>
</tr>
<tr>
<td><strong>Boston</strong> Westborough, MA Tel: 774-760-0087 Fax: 774-760-0088</td>
<td><strong>China - Dongguan</strong> Tel: 86-769-8702-9880</td>
<td><strong>Japan - Tokyo</strong> Tel: 81-3-6880-3770</td>
<td><strong>Fax: 33-1-69-30-90-79</strong></td>
</tr>
<tr>
<td><strong>Chicago</strong> Itasca, IL Tel: 630-285-0071 Fax: 630-285-0075</td>
<td><strong>China - Guangzhou</strong> Tel: 86-20-8755-8029</td>
<td><strong>Korea - Daegu</strong> Tel: 82-53-744-4301</td>
<td><strong>Germany - Garching</strong> Tel: 49-8931-9700</td>
</tr>
<tr>
<td><strong>Dallas</strong> Addison, TX Tel: 972-818-7423 Fax: 972-818-2924</td>
<td><strong>China - Hangzhou</strong> Tel: 86-571-8792-8115</td>
<td><strong>Korea - Seoul</strong> Tel: 82-2-554-7200</td>
<td><strong>Germany - Haan</strong> Tel: 49-2129-3766400</td>
</tr>
<tr>
<td><strong>Detroit</strong> Novi, MI Tel: 248-848-4000</td>
<td><strong>China - Hong Kong SAR</strong> Tel: 852-2943-5100</td>
<td><strong>Malaysia - Kuala Lumpur</strong> Tel: 60-3-7651-7906</td>
<td><strong>Germany - Heilbronn</strong> Tel: 49-7131-67-3636</td>
</tr>
<tr>
<td><strong>Houston, TX</strong> Tel: 281-894-5983</td>
<td><strong>China - Nanjing</strong> Tel: 86-25-8473-2460</td>
<td><strong>Malaysia - Penang</strong> Tel: 60-4-227-8870</td>
<td><strong>Germany - Karlsruhe</strong> Tel: 49-721-625370</td>
</tr>
<tr>
<td><strong>Indianapolis</strong> Noblesville, IN Tel: 317-773-8323 Fax: 317-773-5453 Tel: 317-536-2380</td>
<td><strong>China - Qingdao</strong> Tel: 86-632-8502-7355</td>
<td><strong>Philippines - Manila</strong> Tel: 63-2-634-9065</td>
<td><strong>Germany - Munich</strong> Tel: 49-89-627-144-0</td>
</tr>
<tr>
<td><strong>Los Angeles</strong> Mission Viejo, CA Tel: 949-462-9523 Fax: 949-462-9608 Tel: 951-273-7800</td>
<td><strong>China - Shanghai</strong> Tel: 86-21-3326-8000</td>
<td><strong>Singapore</strong> Tel: 65-6334-8870</td>
<td><strong>Fax: 49-89-627-144-44</strong></td>
</tr>
<tr>
<td><strong>Raleigh, NC</strong> Tel: 919-844-7510</td>
<td><strong>China - Shenyang</strong> Tel: 86-24-2334-2829</td>
<td><strong>Taiwan - Hsin Chu</strong> Tel: 886-3-577-8366</td>
<td><strong>Germany - Rosenheim</strong> Tel: 49-8031-354-560</td>
</tr>
<tr>
<td><strong>New York, NY</strong> Tel: 631-435-6000</td>
<td><strong>China - Shenzhen</strong> Tel: 86-755-8864-2200</td>
<td><strong>Taiwan - Kaohsiung</strong> Tel: 886-7-213-7830</td>
<td><strong>Israel - Ra'anana</strong> Tel: 972-9-744-7705</td>
</tr>
<tr>
<td><strong>San Jose, CA</strong> Tel: 408-735-9110 Tel: 408-436-4270</td>
<td><strong>China - Suzhou</strong> Tel: 86-186-6233-1526</td>
<td><strong>Taiwan - Taipei</strong> Tel: 886-2-2508-8600</td>
<td><strong>Italy - Milan</strong> Tel: 39-0331-742611</td>
</tr>
<tr>
<td><strong>Canada - Toronto</strong> Tel: 905-695-1980 Fax: 905-695-2078</td>
<td><strong>China - Wuhan</strong> Tel: 86-27-5980-5300</td>
<td><strong>Thailand - Bangkok</strong> Tel: 66-2-694-1351</td>
<td><strong>Fax: 39-0331-468781</strong></td>
</tr>
<tr>
<td></td>
<td><strong>China - Xian</strong> Tel: 86-29-8833-7252</td>
<td><strong>Vietnam - Ho Chi Minh</strong> Tel: 84-28-5448-2100</td>
<td><strong>Italy - Padova</strong> Tel: 39-049-7625286</td>
</tr>
</tbody>
</table>

© 2018 Microchip Technology Inc.